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Preface 
This Quick Start Guide gives an overview of the Intel® Integrator Toolkit and 
summarizes the steps to take when using the basic features of the tool.  Refer to the 
following documents for additional information: 

 
• Readme.RTF—Provides both basic and last minute information about the current 

version of the product.  The readme can be found in the Intel Integrator Toolkit 
package. 

• iToolkit.CHM—Provides detailed information to help the user complete a task.  
This HTML help file requires a Microsoft Windows* operating system for viewing 
and includes system messages, troubleshooting tips, and methods to implement 
automated processing. The help file can be viewed by selecting the Help button 
from the command line in the Windows-based interface or Help from the DOS 
command line.  

 

An interactive training tool (under the Resources tab) for the toolkit is available at the 
following site:  http://www.intel.com/design/motherbd/software/itk/resources.htm 

Intended Audience 
The information given in the Quick Start Guide is intended for experienced system 
integrators.   

Intended Use of the Toolkit 
The Intel Integrator Toolkit is a utility used for setting up custom system settings and 
then replicating these settings to other systems in a manufacturing environment.  It 
also allows you to customize a BIOS splash screen where you can display a badge of 
your choice. 

Conventions  
The following conventions are used in the Quick Start Guide: 

 CAUTION 

Cautions warn the user about how to prevent damage to hardware or loss of data. 

 NOTE  

Notes call attention to important information. 

http://www.intel.com/design/motherbd/software/itk/resources.htm
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Glossary 
Term Description 

Batch file A file that contains instructions to run on the system.  This is then used to 
automatically install selected components to a system. 

Modified BIOS 
capsule 

The resulting BIOS file when flex module changes are made. 

DOS Disk operating system 

Flex BIOS A BIOS architecture that allows customization of the functional modules included 
with the BIOS, such as splash screen customization, network boot support, and 
languages.  This architecture allows you to maximize the use of the system’s 
available flash memory space to suit your needs. 

Flex module Includes language packs, logo module, and optional BIOS file settings which can’t be 
modified in INI files. 

PnP Plug and Play 

SMBIOS System Management BIOS 

Windows* PE Microsoft Windows* Preinstallation Environment. A version of the operating system 
that can be booted from various media and does not need to be installed on the 
system hard disk.  It is intended to provide an environment in which manufacturers 
can customize their systems (update BIOS, change system settings, ad perform 
diagnostics) prior to the installation of an operating system to the hard disk. 

WMI Windows Management Instrumentation.  An operating system interface that allows 
system drivers to report information that can be retrieved by applications. 

Workspace A workspace is a reference environment where you can modify system settings, flex 
modules, and create INI and BIO files.  

File Types  
File Extension File Type Use 
.bio  BIOS file The BIOS file(s) contains the BIOS splash screen.  For Flex 

BIOSs, the customized BIOS file also contains Flex Modules 
and splash screen. 

.ini Intel Integrator Toolkit 
configuration file 

The INI configuration file is the output file from the 
Microsoft Windows*- and DOS*-based applications and is 
used as the input file for the DOS-based toolkit application. 
 This file is used to install the configuration settings for 
BIOS settings and SMBIOS on the target systems. 

.itk  Intel BIOS configuration 
file 

Each BIOS configuration file is applicable only to a 
particular BIOS version for an Intel® Desktop Board 
product.  The BIOS configuration file is the required input 
for the workspace, the starting point for the Windows-
based application. 

.itw Intel Integrator Toolkit  
Framework Edition 
workspace  

Workspace for the Intel Integrator Toolkit Framework 
Edition.  In this interface of the toolkit, the workspace file 
is your working environment.  It contains your current 
settings for the BIOS you have selected.  The workspace 
allows you to generate INI and BIO files. 

.txt Text A report that presents all of the configuration settings 
contained in the workspace in a text file.  It also contains 
target system report when the Generate a Target System 
Report command is used in the DOS-based tool. 
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Overview 

The Intel Integrator Toolkit is used to customize system settings and then replicate 
these settings in a manufacturing environment.  The toolkit comes with different 
interfaces to accomplish these tasks.  The DOS*- and Microsoft Windows* PE-
based interfaces can be used to both configure and install the customized system 
settings onto target systems.  The Windows-based interface (Intel Integrator 
Toolkit Framework Edition) can be used as a virtual system builder to customize 
system settings; you will have to use either the DOS- or Windows PE-based 
interface of the toolkit to install these settings onto target systems.  
 
The table below shows the capabilities of each interface: 
 

Task Intel® Desktop 
Board  

Intel Integrator Toolkit Interface 

DOS1-based interface to configure 
and then install configured settings 
onto target systems. 

Configure system 
settings and/or 
install customized 
settings  

 
Intel® 945 or higher 
chipset 

Microsoft Windows* PE-based 
interface to configure and then install 
configured settings onto target 
systems. 

Configure system 
settings  
 

Intel 945 or higher 
chipset 

Intel Integrator Toolkit Framework 
Edition to configure virtually (use the 
DOS- or Windows PE-based interface 
to install configured settings onto 
target systems). 

1 – Both Microsoft MS-DOS* and ROM-DOS* have been validated with Intel Integrator Toolkit 3.2. 
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The diagrams below show the function the different interfaces of the Intel 
Integrator Toolkit perform in the process of replicating system settings onto target 
systems.   

 

 

Conceptual Overview of the Intel® Integrator Toolkit System Configuration 
Process 
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Configuring Settings 

This chapter gives general information about configuring system settings using the 
different features of the tool and preparing files to install on a target system.  You 
may configure system setting using any of the Intel Integrator Toolkit interfaces.  
Refer to the iToolkit.chm help file for more detailed information.  
 
This chapter consists of two main sections: 
• Configure Using the Microsoft Windows-based Interface 
• Configure Using the DOS- or Microsoft Windows Preinstallation Environment 

(Windows PE)-based Interface 

Configure Using the Microsoft Windows*-
based Interface 

The Intel Integrator Toolkit Framework Edition acts as virtual system builder, 
allowing you to configure the system's BIOS, SMBIOS, and Flex Module settings in 
a GUI environment, and create a reference-free INI file.  This interface requires an 
Intel Integrator Toolkit-enabled BIOS (an .itk file in the BIOS package).  If the Flex 
Modules in the BIOS are modified, the interface creates a modified BIOS capsule 
also.   
 
This Windows-based interface can be used in place of the extract function in the 
DOS- or Windows PE-based interface of the toolkit.  However, the DOS- or 
Windows PE-based interface is required to install the INI file settings onto target 
systems. 
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The left-hand pane contains the hierarchical tree of BIOS Settings, SMBIOS, and 
Flex Modules nodes and leafs.  The right-hand pane displays the configurable 
settings in rows for the node selected in the left-hand pane.   
 
The workspace contains a toolkit toolbar with icons that let you lock or hide BIOS 
settings, if your BIOS allows; prompt the user for SMBIOS settings; generate INI 
files; and generate reports.  Most of these commands are also available on the 
main menu; Generate INI and Generate BIOS are the two exceptions and are 
combined under Generate Installation Files on the main menu.  You can set default 
directories for the files the toolkit uses.  The table below shows the seven toolkit 
icons and their descriptions: 

Icon Name Description 

 
Lock BIOS Setting(s) Prevents the end-user from editing specified BIOS 

settings. 

  
Hide BIOS Setting(s) Hides specified BIOS settings from the end-user. 

   
Prompt for SMBIOS Value(s) Specifies SMBIOS settings that the end-user will 

be prompted to enter a value. 

  
Generate Installation Files Generates the following installation files: 

• INI file: consisting of the BIOS settings and 
SMBIOS values in the current workspace. 

• Custom BIOS Update:  an executable file that 
contains the modified BIOS settings.  

• After Flex Module settings are configured, 
generates a modified BIOS file that includes 
these changes.  

  
Generate Report Generates a report consisting of the BIOS 

settings, SMBIOS values, and Flex modules in the 
current workspace. 

 
Generate Media 

 

After BIOS, SMBIOS, and/or Flex modules are 
configured, generates media containing settings 
that will be installed on target systems.  Used with 
the DOS-based interface. 

Prepare Work Environment 
To get started, you will need to first download the correct BIOS for your Intel® 
Desktop Board.   

Download BIOS Update 
To download a BIOS update: 

1. Go to http://www.intel.com/support/motherboards/desktop/ . 
2. Select your Intel Desktop Board. 
3. Select “Latest BIOS and driver updates.” 
4. Select your operating system. 
5. Click BIOS Update. 

http://www.intel.com/support/motherboards/desktop/
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6. From the given choices, download the Iflash BIOS update with the following 
extension: XXXX.IB.ZIP. 

7. Double click the SW.EXE file.  The following files will be saved to your system: 
• Xxxx.xxxx.exe 
• Xxxxxxxx.dll 
• Xxxxxxxxx.itk 

The .itk file is included in the BIOS download (Flash only).   

 

 NOTE  

If only the BIOS.EXE file is displayed, double click it to extract all the files.  Look 
for the SW.EXE file; double click it to extract its contents.  
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Create a Workspace 
A workspace is an environment where you can make changes to system settings 
and create an INI file.   

To create a workspace on your system: 

1. Launch the Intel Integrator Toolkit Framework Edition. 
2. Click New on the standard toolbar or on the File menu, click New 

Workspace. 
3. Browse to locate the folder where the Integrator Toolkit (.itk) you want to 

open is located. 
4. In the Add Components to Workspace pane, unmark the check boxes for 

those items you do not want to include in this workspace. 
5. Click OK. 
  

 NOTE  

For the .itk file to update Flex Modules (such as the splash screen), the .itk and 
.bio files must both be located in the same directory you are referencing.  
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Define BIOS Settings 

 CAUTION 

Incorrect system BIOS settings may cause a system to malfunction, fail to boot, or 
operate with decreased performance.  Incorrect BIOS settings may affect system 
stability and functionality.  Customization of system BIOS settings is intended for 
use only by professional PC system integrators.  
 

In the BIOS Settings node, you can replace the original factory default settings for 
any specified BIOS value. 

To define BIOS settings:  

1. In the left pane of the main window, expand the BIOS Settings node until you 
see the component you wish to configure.  

2. In the left pane, select the component you wish to configure.  The configurable 
items will appear in the right pane. 

3. In the right pane, select the item you wish to configure. 
4. Double click in the Value column to edit the value for that item. 

 

 

Notes: 

• The above screen shows only a sample BIOS Settings node.  Any content in the node 
may vary significantly between BIOS files for specific Intel Desktop Board products. 

• The asterisk mark (*) indicates the default BIOS value for a setting. 
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Lock or Hide BIOS Settings  
There may be times when you will want the end-user from not accessing or 
changing BIOS settings.  The lock or hide features are the two choices for doing 
this: 

• Locking BIOS settings: The lock option, in the pop-up menu, allows the end-
user to see the BIOS setting, but not modify it.  To prevent the end-user from 
editing a BIOS setting, right-click in that item’s row and click the Lock option in 
the pop-up menu or select the item’s row and click the Lock BIOS Setting(s) 

 icon in the toolkit toolbar. 
• Hiding BIOS settings:  The hide option, in the pop-up menu, prevents the 

end-user from seeing or modifying the BIOS setting.  To hide specified BIOS 
settings from the end-user, right-click in that item’s row and click the Hide 
option in the pop-up menu or select the item’s row and click the Hide BIOS 

Setting(s)  icon in the toolkit toolbar. 

 NOTES  

BIOS settings can be either locked or hidden, but not both.  If a setting is hidden, 
it is also locked. 

Only a limited number of settings can be locked or hidden if you are using the 
Windows-based Integrator Toolkit interface.  The number will vary depending on 
the BIOS being used. 

 

Note: 

The above screen shows only a sample BIOS Settings node.  Any content in the node may 
vary significantly between BIOS files for specific Intel desktop board products. 
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Define SMBIOS Settings  
In the SMBIOS node, you can enter values or opt to display a prompt at install 
time to enter descriptive information about the system and chassis.  For SMBIOS 
information, go to http://www.dmtf.org/standards/smbios/ . 

   

To define SMBIOS settings: 

1. In the left pane of the main window, expand nodes until you see the SMBIOS 
node.  The configurable items for the SMBIOS component will appear in the 
right pane. 

2. In the right pane, select the item you wish to configure. 
3. Double click in the Value column to edit the value for that item. 

 

4. To prompt for input of SMBIOS values during the installation process, right click 
on that item’s row and click Prompt from the pop-up menu or select the item’s 
row and click the Prompt for SMBIOS Values   icon on the toolkit toolbar. 

Note: 

The above screen shows only sample SMBIOS content. 

http://www.dmtf.org/standards/smbios/
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Select Flex Modules 
The Flex Module node includes optional language packs and may include other 
optional modules.  The toolkit also provides a customizable BIOS splash screen as 
a required Flex Module with an optional badge feature.  

 NOTE  

If you wish to change the BIOS language, you must make sure that the language 
you want is one of the languages listed in the Flex Module node.  

 

To define flex module settings: 

1. In the left pane of the main window, expand the nodes until you see the Flex 
Modules node.   

2. In the left pane, click the Flex Modules node.  In the right pane, select the 
module of the item you wish to configure. 

3. Right click the item to edit the content of that cell. 
4. After you complete all Flex Module setting changes, click the Generate 

Installation Files  icon on the toolkit toolbar to generate a new .bio file. 

 

 

Note: 

The above screen shows only a sample of Flex Module content.  The Flex Modules available 
may vary significantly between BIOS files for specific Intel desktop board products. 
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Customize a Splash Screen 

 NOTE  

The splash screen can be set using a bitmap or baseline JPEG image.  Only 
baseline JPEG images are supported; all other types of JPEG images, such as 
progressive JPEGs are not supported. 

 

The Flex Module includes a feature where you can customize the default BIOS 
splash screen with your own full-color graphics file. 

To customize a splash screen: 

1. In the left pane of the main window, select the Flex Modules node. 
2. Right-click the Logo component. 
3. In the Customize BIOS Splash Screen window, go to File  Open Graphics 

File… 
4. Browse to locate the graphics file you wish to include. 
5. Click Open. 
6. To display the badge and choose a location on the screen, click File  Open 

Graphics File from the Customize BIOS Splash Screen window.  Then select 
Edit Badge Location to place the badge in a location of your choice on the 
screen. 

7. To save the new splash screen file, go to File  Update BIOS File.  To exit 
without saving the graphics file to the BIOS file, go to File  Exit. 
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Generate Installation Files 
The files generated in this dialogue are those you will use to install the configured 
system settings onto target systems using either the DOS-based or Windows PE-
based Intel Integrator Toolkit.  The three files that can be generated from this 
feature are a BIO File, Custom BIOS Update, and INI File. 

Generate a BIO File  
To generate a BIO file: 

1. After configuring settings, select Generate Installation Files… from the File 
menu or click the Generate Installation Files  icon on the toolkit toolbar. 

2. Mark the check boxes for those items you want to include in this BIOS file. 
3. Click Browse… to locate and open the desired file on your hard drive. 
4. In the File name field, type a name for the BIOS file. 
5. Click OK. 

Generate Custom BIOS Update 
To generate an executable Custom BIOS Update: 

1. After configuring settings, select Generate Installation Files… from the File 
menu or click the Generate Installation Files  icon on the toolkit toolbar. 

2. Mark the check boxes for those items you want to include in this BIOS update. 
3. Click Browse… to locate and open the desired file on your hard drive (for 

example, C:\temp\cb.exe). 
4. In the File name field, type a name for the BIOS update. 
5. Click OK. 
 

To run the Custom BIOS Update: 

1. Locate the file that was just saved using the Generate Installation 
Files/Generate Custom BIOS Update (in this example C:\temp\cb.exe). 

2. Double click the .exe file. 
3. Respond to the prompts as they appear. 
4. Click Finish. 

Generate an INI File 
To generate an INI file: 

1. After configuring settings, select Generate Installation Files… from the File 
menu or click the Generate Installation Files  icon on the toolkit toolbar. 

2. Mark the check boxes for those items you want to include in this INI file. 
3. Click Browse… to locate and open the desired file on your hard drive. 
4. In the File name field, type a name for the INI file. 
5. Click OK. 
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Generate Media 
The Generate Media feature generates and copies all files to a specified location, 
such as a portable USB drive, along with a batch file to execute those files using 
the DOS-based installation tool. 

 NOTES  

The Generate Media feature applies only to DOS or itoolkit.exe related files. 

The instructions below assume that you will be using a portable USB drive as the 
output media for the files.  If you use a floppy for generating media, follow the 
steps in the Generate Media topic in the iToolkit.chm help file.  

To generate media: 

1. Click the Generate Media  icon on the toolkit toolbar. 
2. In the Files tab, browse to the destination folder where the files will output (a 

portable USB drive). 
3. In the Generate Batch File pane, mark the Create Batch File check box to 

create a batch file. 

 NOTE 

Use this feature when you will use an automated process to install customized 
settings to a target system. The Generate Batch File will generate an Autoexe.BAT 
file for this purpose. 
4. In the Install Components subpane, mark the check boxes for the 

components you wish to copy to the target location. 



Intel Integration Toolkit:  Quick Start Guide 

20     

 NOTE  

Flex Modules, such as splash screen, are updated in the Options tab, covered in 
step 6. 
5. To copy the DOS toolkit executable, mark the Copy iToolkit.exe to disk check 

box. 

 

 

6. In the Options tab, enter a base executable file name, which will apply to the 
INI, log, and report files. 

7. In the Generate Batch File/File Locations pane, mark the BIOS File check 
box to include the existing BIOS file. 

8. If you made changes to the Flex Modules, for example the splash screen, 
browse to select the BIOS that you created previously (see Customize a Splash 
Screen in this document). 

9. In the iToolkit Options subpane, mark the options you wish to include in the 
resulting iToolkit.exe file. 

10. Click OK. 
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Generate a Report 
You can generate a report of your system's settings in a formatted text file. 

 

To generate a report: 

1. After defining a workspace, click the Generate Report icon  on the toolkit 
toolbar or on the File menu, click Generate Report...   

2. In the Select Components to Report pane, mark the check boxes for those 
items you want to include in this report.   

3. Click OK. 
4. In the Save As dialog box, if you want to save the report in a different folder, 

locate and open the desired folder. 
5. In the File name field, type a name for the report.  
6. Click Save. 

  

Install Configured Settings onto Target Systems 
For information about installing the customized toolkit configurations onto the 
target system(s), refer to the section titled Manufacturing Environment in this 
document. 
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Configure Using the DOS- or Microsoft 
Windows Preinstallation Environment 
(Windows PE)-based Interface 

The DOS- and Windows PE-based interfaces of the Intel Integrator Toolkit use a 
reference system to read system settings, customize them, and then create an INI 
file.   

The following command line is used in this section: 

EXTRACT—Retrieves customized BIOS, SMBIOS, as well as BOM information (in 
the DOS-based Intel Integrator Tool only) from a reference system.  Editable 
tokenized settings let you extract all CMOS settings and then insert only updated 
settings into the INI file. 

 

When you download the Intel Integrator Toolkit to your hard drive, it will create a 
folder called Intel(R) Integrator Toolkit.  You will find the DOS-based interface in 
the Tool for DOS subfolder, and the Windows PE-based interface in the Tool for 
Windows PE subfolder.     

 

Double click the folder of your choice to start working with the tool.   
1 – Both Microsoft MS-DOS* and ROM-DOS* have been validated with Intel Integrator Toolkit 3.2. 

 NOTES  

The Windows PE image used in conjunction with this application must be built using 
the Microsoft Vista*, Microsoft Windows XP Professional Edition with Service Pack 
2, or Microsoft Windows Server 2003.   Microsoft Windows PE images based on 
other versions of Microsoft Windows XP are not supported. 

In the Windows PE-based interface, neither the PnP nor WMI options are required 
to run the Intel Integrator Toolkit installer. 
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Prepare Work Environment 

 NOTE  

For information about creating bootable media (floppy disk, USB flash drive, CD-
ROM), go to the following Intel website: 
http://www.intel.com/design/motherbd/standardbios.htm 

 NOTE  

Windows PE files will have a W at the end of the file name; for example, 
itoolkitW.exe. 

In this section, you will: 

• Prepare a floppy or other media for reference system extraction 
• Configure the reference system and then extract desired customized settings 
• Prepare a bootable media with the finalized INI file 

Prepare an Extraction Disk 
Run the iToolkit.exe to extract toolkit files to a directory of your choice.  Then 
create a bootable media containing the following files: 

 

Intel Integrator 
Toolkit  

Required Files Optional Files 

DOS-based Itoolkit.exe — executable file for 
Intel Integrator Toolkit  

MSDOS* bootable files — includes 
user added files such as Microsoft’s 
Command.com, Msdos.sys, and 
Io.sys  

Iflash and BIOS files — user 
added files, if needed 

Editor — includes editors 
such as Edit.com with 
Qbasic.exe 

Windows PE-
based 

ItoolkitW.exe 

ItoolkitWRes.dll 

ItoolkitW.dll 

EfiVar.dll 

Variable.sys 

Invoker.dll 

Invoker.sys  

BIOS files — user added 
files, if needed 

 

http://www.intel.com/design/motherbd/standardbios.htm
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Define BIOS Settings 
Once you have built the reference system and, if needed, flashed the reference 
system’s BIOS to the desired version, you may want to define BIOS settings if: 

• You want to automatically configure all BIOS settings 
• You have access to a reference system using the same BIOS version as those 

being configured 
• You would rather create a configuration using F2 BIOS Setup than the 

Windows-based configuration tool 
• You have already set up a reference system with the BIOS settings that you 

want 

To define BIOS settings: 

1. Use BIOS F2 Setup to configure the BIOS settings on your reference system. 
2. Boot to DOS or Windows PE on your reference system. 
3. Run itoolkit[w] extract –config –ini=xxx.ini. 

Define BIOS Settings Using Tokens  

 NOTE  

The token extract and install feature is only valid for Intel desktop boards that 
have an Intel 945 or higher chipset.   

Token settings provide a method for extracting BIOS settings from a reference 
system into an INI file with plain text.  Once these settings are extracted to an INI 
file, they can be individually edited in the INI file.  Each extracted token setting can 
be cut and pasted to other INI files.  This allows the user freedom to only set 
CMOS settings that are needed.  The advantage to using tokens is that it is BIOS 
independent and can be used on any system.  The tokenized settings can then be 
installed onto any supported target system.   

You may want to use tokens to define BIOS settings if: 

• You would like your INI file to contain individually text editable BIOS settings 
• You only need (or want) to program those BIOS settings explicitly identified in 

your INI file 
• You are not able (or do not want) to use the Windows-based Intel Integrator 

Toolkit configuration tool 
• You do not have access to a .itk file for your system BIOS 

To define BIOS settings using tokens: 

1. Boot to DOS or Windows PE on the reference or target system. 
2. Run itoolkit[w] extract –tokens –ini=xxx.ini. 
3. Edit xxx.ini: 

• Modify tokenized settings that you would like to program 
• Delete tokenized settings that you want to leave set to their current settings 
• Set the lock and hide properties (to true or false) for settings  that you do 

or do not want hidden (this can be done only in Windows PE) 
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The following provides examples of command lines for the token extract operation: 

• ITOOLKIT EXTRACT[W] -tokens [-INI=<INI file name>] 
Extracts just the tokenized settings to the specified or default INI file. 

• ITOOLKIT EXTRACT[W] -tokens <other component flags> [-INI=<INI 
file name>] 
Extracts the tokenized settings to the specified or default INI file, as well as the 
other components specified. 

For more detailed information, go to the Token Extract and Install Component topic 
in the iToolkit.chm help file. 

Define SMBIOS Settings 
You may want to define SMBIOS settings if: 

• You are not able (or don’t want) to use the Windows-based Integrator Toolkit 
configuration tool 

• You want to replicate the SMBIOS strings from a reference system to one or 
more target systems 

• You do not have access to a .itk file for your system BIOS 

To define SMBIOS settings: 

1. Boot to either DOS or Windows PE on your reference or target system. 
2. Run itoolkit[w] extract –smbios –ini=xxx.ini. 
3. Edit xxx.INI: 

• Modify SMBIOS strings that you would like to program 
• Delete SMBIOS strings that you want to leave set to their current values 
• Set SMBIOS strings that you would like cleared to an empty value, such as 

“SystemManufacturer=” 

Customize the INI File 

To prompt for input of SMBIOS values during the installation process, enter 
$PROMPT$, and the prompt text string after appropriate keyword within the SMBIOS 
section of the INI file.  For example:  
SystemSerialNum=$PROMPT$, “Enter Serial Number:” 
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Prepare the Installation Disk 

 NOTE  

For information about BIOS updates and creating bootable media, go to the 
following Intel website: http://www.intel.com/design/motherbd/standardbios.htm 

 
Create a bootable disk (bootable USB flash drive or floppy disk) as required for 
your specific manufacturing process containing the following files: 
 
Intel Integrator 
Toolkit Interface 

Required Files Configured Files Optional Files 

Windows PE-
based 

ItoolkitW.exe 

ItoolkitWRes.dll 

ItoolkitW.dll 

EfiVar.dll 

Variable.sys 

Invoker.dll 

Invoker.sys 

iToolkit.ini — the file generated after 
system settings are configured using 
any of the Intel Integrator Toolkit 
interfaces. 

Modified BIOS capsule —generated 
after the Intel Integrator Toolkit 
Framework Edition configuration tool 
is used.  It includes the base BIOS 
and customized flex modules. 

 

 

DOS-based iToolkit.exe iToolkit.ini — the file generated after 
system settings are configured using 
any of the Intel Integrator Toolkit 
interfaces. 

Modified BIOS capsule — generated 
after the Intel Integrator Toolkit 
Framework Edition configuration 
tools is used.  It includes the base 
BIOS and customized flex modules. 

Iflash 

Customize a Splash Screen (Windows PE only) 

 NOTE  

The splash screen can be set using a bitmap or baseline JPEG image.  Only 
baseline JPEG images are supported; all other types of JPEG images, such as 
progressive JPEGs are not supported. 

You may want to customize a BIOS splash screen if: 

• You want to dynamically select a .jpg file at install time 
• You don’t have any need to run the Intel Integrator Toolkit Framework Edition 

configuration tool 

To install a custom BIOS splash screen: 

1. Obtain a .bio file for your Intel desktop board. 
2. Boot to Windows PE. 

Run itoolkitw flash –bio=xxx.bio –splash=zzz.jpg (where zzz.jpg is your 
image file).

http://www.intel.com/design/motherbd/standardbios.htm
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Manufacturing Environment 

Now that the configuration of system settings is complete, you can install these 
settings onto target systems in the manufacturing environment.   

The following command lines are used in this section: 

• FLASH—Updates the system BIOS version when necessary. 
• INSTALL—Replicates customized BIOS or tokenized settings in the 

manufacturing environment.  Editable tokenized settings also let you install 
only the CMOS settings that are needed on target systems. 

• REMOVE—Removes BIOS and SMBIOS settings from a target system and 
returns the system’s configurations to their original state. 

• VERIFY (DOS-based interface only)—Verifies BOM information to make sure 
the target system configuration matches the reference system to increase build 
quality. 

• REPORT (DOS-based interface only)—Generates a BOM report file for 
viewing or printing. 

In this section, you will: 

• Make sure BIOS version of target system matches that of reference system.  
Flash the BIOS if necessary 

• Install the customized settings onto target system(s) by booting to the bootable 
media 

Install Configured Settings onto Target 
Systems 

The -install switch replicates customized BIOS and tokenized settings in the 
manufacturing environment.  Editable tokenized settings also let you install only 
the CMOS settings that are needed on target system(s). 

 If you want to simply install customized settings: 

1. Boot the target system to the installation disk (portable USB or floppy).  If 
necessary, flash the BIOS. 

2. Enter the command:  itoolkit[w] install or itoolkit install.  This 
command installs the BIOS and SMBIOS settings on the target system using 
data from the iToolkit.ini file.   

If you use automated procedures to install customized settings: 

1. The autoexec.bat file might execute the following example tasks: 
• Flash BIOS to correct version, if necessary:   

itoolkit[w] flash –bio=file.bio 
• Set DATE and TIME 
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• Execute additional Integrator Toolkit commands:   
itoolkit[w] install 

2. For more information on using automatic processes, go to the Sample.ZIP topic 
under the Examples section in the iToolkit.chm help file. 

Install Tokenized Settings  

 NOTE  

When using both config and token features, config features will be installed first, 
but the token features will overwrite any corresponding config features. 

To install to a target system only the tokenized settings found in the specified or 
default INI file, use the command:   
itoolkit[w] install –tokens [ini=<ini file name>] 

Other Command Features 

Remove Customized Settings from Target System 
To remove BIOS and SMBIOS information from the target system: 

1. Use the command:  itoolkit remove. 
2. The target system’s settings are returned to factory defaults. 

Verify Target System BOM against Reference System 
(DOS only) 

To verify the target system BOM against the reference system: 

1. Use the command:  itoolkit verify –log=filenam1.log. 
2. If the configuration of the target system does not match the configuration of 

the reference system, warnings will appear. 
3. You may also note differences between the target and reference system as 

captured in the logged file called “filenam1”. 

Generate a Target System Report (DOS only) 
To prepare a BOM report on the target system: 

1. Use the command:  itoolkit report 
2. A Report.TXT file is created during system report generation. 
3. View, print, and/or edit Report.TXT as needed. 

Command Summaries 
See Command Line Options in the iToolkit.chm help file for command naming 
parameters and usage instructions. 
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Windows PE Commands 
 
GENERAL SYNTAX FORMAT: iToolkitW command [-switch]...[-switch]                  

   

iToolkitW EXTRACT [-CONFIG] [-SMBIOS] [-tokens] [-ini=<file>]           

        [-log[=<file>]]                                            
   

iToolkitW INSTALL [-CONFIG] [-SMBIOS] [-tokens] [-ini=<file>]  

[-log[=<file>]]                              
   

iToolkitW FLASH   -bio=<file> [-splash=<file> [-badge]]  
   

iToolkitW REMOVE  [-CONFIG] [-SMBIOS]                               
    

Commands without switches:  iToolkitW HELP   or  iToolkitW?                        
          Default filenames: iToolkit.ini, iToolkitW.log  
  Defaults shown in uppercase text above.  Syntax entry non-case sensitive.      

Refer to the Readme.RTF or iToolkit.CHM files for more information.          

DOS Commands 
GENERAL SYNTAX FORMAT: iToolkit command [-switch]...[-switch]                  
   

iToolkit EXTRACT [-CONFIG] [-SMBIOS] [-BOM] [-tokens] [-ini=<file>]                       

                   [-log[=<file>]]                               
   

iToolkit INSTALL [-CONFIG] [-SMBIOS] [-tokens] [-ini=<file>]                               
                   [-log[=<file>]] [-reboot]                     
   

iToolkit FLASH   -bio=<file> [-force]                                        
   

iToolkit REMOVE  [-CONFIG] [-SMBIOS] [-reboot]                               
   

iToolkit REPORT  [-BOM] [-txt=<file>]                                        
   

iToolkit VERIFY  [-BOM] [-ini=<file>] [-log[=<file>]]                        
   

Commands without switches:  iToolkit HELP     iToolkit ?     iToolkit REBOOT 

        Default filenames: iToolkit.ini, iToolkit.log, Report.txt              
Defaults shown in uppercase text above.  Syntax entry non-case sensitive.      

Refer to the Readme.RTF or iToolkit.CHM files for more information.          
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